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Chapter 1: Introduction 
 
Overview of this document 
 
The purpose of this instructional document is intended for LaGuardia Students who wish to 
develop their own ePortfolio.  Each student has an ePortfolio account connected to their student 
Blackboard Account.  In your time here at LaGuardia, you can create several different kinds of 
ePortfolios.  For example, students may want to create separate ePortfolios for the purposes of 
transfer, employment, or family and friends.  The step by step instructions here will guide you to 
create your ePortfolio, which can be stored in the LaGuardia’s web based storage area or publish 
it online. 
 
LaGuardia's ePortfolio system is very flexible.  If you can use Microsoft Word, you will have no 
problem following the instructions in this document.  This document also contains some 
background and information on the happenings of ePortfolio here at LaGuardia and around the 
country.  You’ll learn that creating your ePortfolio requires you to really think about what kind of 
message you want to convey and share it with others for feedback.  It is with feedback and self-
reflection that will help you revise your ePortfolio to a well-polished, professional web page. 
 
Resources Needed 
 

• Internet Access  
• Netscape Composer (which usually comes pre-installed in most computers) 
• Web Browser (for example: Internet Explore or Netscape) 

 
 
PLEASE NOTE: See Chapter 11 for information on where on the web you can download these 
tools.  Also, see Chapter 13 for more information on Support & Resources! 
 
What is an ePortfolio? 
 Collection of student work and student reflections, made available on the Web 
 Digital format adds versatility, portability, and visibility  
 Growing Movement – 50+ Colleges & Universities 
 
Learning History    
 The ePortfolio represents a learning history. It serves as a way for students and faculty 
 to assess student progress and encourages students to take more responsibility for their 
 own learning.  The ePortfolio brings together curriculum, instruction, and assessment. At 
 LaGuardia, the ePortfolio will also advance program assessment, based on a rich 
 understanding of our students and their learning.  Beginning this year, the ePortfolio will 
 become an integral part of the First Year Experience Academies, providing students with 
 a year-long opportunity to work within a community of learners.   
 
ePortfolio @ LaGuardia 
 
Collect: Students collect their work 
Select:  Students choose samples of work that show their learning 
Reflect:  Students identify & articulate evidence of growth 
Connect:  Students use the web to share work w/ family, friends, employers, etc. 
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Potential Benefits  
 
Students 
Provides a vehicle for self-assessment and reflection 
Links the Classroom to Lived Experience 
Improves Technology Skills 
Promotes Transfer and Career Development through a digital Resume 
 
Faculty and the College 
Provides a better picture of who our students really are and a richer understanding of how our 
students learn 
Improves Advisement, Transfer & Career Guidance 
Guides Program and Institutional Assessment 
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Student Feedback 
 
The Best Part of Creating an ePortfolio 
70% of students felt the ePortfolio made their course more interesting 
66% of students felt the ePortfolio helped them learn. 
“Creating a Professional Site about myself.” 
“It was a new experience and it was pretty cool.” 
“The teamwork in the labs.” 
“It gave me the opportunity to examine my own career goals and ambitions for life.” 
“The best part of creating the ePortfolio was instead of the teacher doing everything for us, they 
directed us step by step, and worked with us individually.” 
 
  
 
 
The Worst Part of Creating an ePortfolio 
 
“Time consuming.” 
“Templates were too limited.” 
“Less class time.” 
“Not enough time.” 
“Deciding what to write.” 
“Making revisions.” 
 
 
 Faculty Feedback    
 
“It was exciting to see [students] develop their ideas visually and to balance language with visual 
display.”  
 

–  Will Koolsbergen, Humanities 
 
“The connection between learning and creating/doing was brought home to me in that it was the 
practical application of what was being learned in the classroom that inspired and motivated the 
students to learn and improve their sites.”  
 

–  Sonja Tanner, Philosophy 
 
“The computer component stimulated the students, making the course seem more relevant to 
their interests and concerns, less fuddy-duddy.”  
 

–  Gordon Crandall, Math 
 
“ePortfolios are part of a conversation that we have to capture in order to understand where our 
students are academically and personally, helping us move forward.”  
 

–  Nancy Gross, Academic ESL 
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Chapter 2: Getting Started 
 
Step 1: Take the Self Survey  
If your Professor does not determine you’re the type of ePortfolio you should work on, then 
simply take the quiz in order to determine your Portfolio type. The quiz is available on online at:  
http://dev.lagcc.cuny.edu/winston/webapplication1/Survey.aspx.  
 
Below are the questions you will find online.  After completing the quiz, go to the top of the 
screen and you will find the level that the system has determined what type of portfolio best 
matches your computer skills: Basic ePortfolio, Intermediate ePortfolio, or Advanced  ePortfolio.   
 
 

Survey Question Answers 

Somewhat 

Fairly 
How comfortable are you doing things like copy and 
paste, bolding text, and changing the alignment of text 
using your word processing program? 

Very 

No 
Do you know how to use a word processing program? 

Yes 

No 
Have you ever worked with Flash? 

Yes 
No Have you ever used an image editing program to resize, 

crop and/or manipulate an image? Yes 

No 
Do you know what HTML is? 

Yes 
Not at all 
Some what comfortable How comfortable do you feel in learning new software? 
Very comfortable 
No 

Do you know how to zip a file? 
Yes 
No 

Do you know how to attach a document to an email? 
Yes 
No 

Have you ever created a web page? 
Yes 
1 to 2 
3 to 5 Approximately, how many hours a week do you use a 

computer? 
5 and up 

 

Submit
 

 
 
 
 
 

Building an Intermediate ePortfolio v.1.5_hg_10152004          5 

http://dev.lagcc.cuny.edu/winston/webapplication1/Survey.aspx


Intermediate ePortfolio: Chapter 2 

Step 2: Browsing informational site  
 
2a. Open Internet Explorer and type the following Url: 
http://www.eportfolio.lagcc.cuny.edu/index.html
 
2b.  Navigate your mouse cursor to Develop your ePortfolio. This area gives you information 
about the related links that will help orient you on how to create your ePortfolio.  (see image 2.1) 
 

 
  
 

1

2c.  Navigate your mouse cursor to Select your Templates.  Look through all the
options and decide which template you like best for your ePortfolio. 
 
2d.  Click on Download Template # that you have decided to use for your ePortf
 
 
Step 3: Select & Copy Templates to your Floppy or Removable Stora
 
3a.  Once the ftp window opens, click on:  Menu > Edit  > Select All 
3b.  Then, go to Menu and select Edit  > Select All > Copy 
3c.   Minimize the window. 
3d.   Next, open Floppy Drive window by going to My Computer. Once Floppy Driv
              Window Opens, do the following:   (see image 2.2) 
 

 
       
           
3e. Create new folder by selecting the following: Menu > File > New > Folder 

2

3f.   Name the folder: ePortfolio.  
(PLEASE, MAKE SURE THERE IS NO COMMA OR SPACES IN EPORTF
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3g.  Double click on the eportfolio folder and select the following:  File > Edit > Paste         
(see image 2.3) 
                

 
 
 
            
3h.   Close the window on the upper right hand corner and click on the X

3 
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Chapter 3: Modify Intermediate Template with 
Netscape Composer 
 
Once you've selected and downloaded your Template, you can begin to modify it and add your 
content (your ideas, your pictures, and your work).   
 
Step 1: Open index.html file.  
1a. Double-click the Netscape 6 or Netscape 7 icon on the desktop. (See image 3.1)  
 

 
 

Image 3.3

 
1b. Choose Composer from the Netscape Window Menu. (See image 3.2) 

 

 
 

Image 3.1

Image 3.2 
 1c. Navigate your mouse cursor to the Menu Bar and click on File.   Then, select Open      File. 
(See image 3.3) 
 

 
 
 
 
1d. Open Template file. Go to the folder where your template files are located.  
 
(For example, if your template files were located in your floppy drive you would select the 
following path:  My Computer > Floppy Drive > ePortfolio > index.html) 
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1e. Select the index file and click Open. (See image 3.4) 
 

 
 
Step 2: Add Text to a Template Page.  
 
2a. Place your cursor on the page and replace the existing text with a sentence welcoming 
visitors to your site. This method is identical to the way in which you would add information in 
any standard word processing application. (See image 3.5)  

          
 
 Image 3.5 
Step 3: Formatting Text  
In Netscape Composer, you can format your text as you would in any other word-processing 
program using the buttons on the menu bar.  You can do the following from the menu bar: Make 
the text Bold; Italicize; change font size; change text color. (See image 3.6) 

 
Image 3.6 
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PLEASE NOTE: To format your text, you can do the following from the pull down menu:  
Highlight text and choose font options from the “Format” pull-down  
Menu (see image 3.7) 
 

 
 Image 3.7 
 
 
 
Step 4: Inserting images. 
4a. Place your cursor in the page where you want your image inserted. 
 
4b. Choose Image from the Netscape Task bar menu. (See image 3.8) 
 

 
 

Image 3.8 
 
4c. Click on Choose file button and search for your ePortfolio template folder by going to My 
Computer and select the Floppy drive or wherever you have your Images folder located.   
 
4d. Select an image inside the image folder that you want to insert and click Open.   
 
 
 
PLEASE NOTE:  
 
Images must be inside of your template folder in order for you to use them. 
 (See image 3.8) 
   
If you want to add your own images from the internet or from somewhere else on your 
computer, they must be copied into to the Images folder before you insert it into your 
ePortfolio web page. 
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4e. Type a description for the image into the Alternate text field. Then, click OK.  
(See image 3.9)  
 

 
 

Image is located inside 
the image folder 

 
 
4f. Align the image as shown in Image 3.10.  Click Align Text to Image and select one of the 
options that appear in the drop down box. 

Image 3.9 
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Step 5: Modify Page Colors and Backgrounds 
In this section we will learn to do the following: modify text colors, create hyperlinks, change 
page colors and Background. 
 
5a. Click on Format in the menu bar and select Page Colors and Background.  
  (See image 3.11) 
 

Image 3.11
 

 
 
5b. Click the Use Custom Colors radio button. (See image 3.12) 
 

Image 3.12

 
 
 

5c.  Click on the colored squares next to Normal Text and choose a color for the text on your 
page. Then, click OK.  (See image 3.13) 

 
 

Image 3.13 

5d.  Repeat Step 5a and 5b.  Next, click on the colored squares next to Link Text. 
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5e.  Select a color for the Link Text and click OK.  
 
Step 6: Inserting Links 
 
6a. Choose “Link” from the “Insert Menu.” (See image 3.14) 
 

Image 3.14 
 

 
 
6b. Under Link Text, enter the name of the link in the text box. 

 
 
 
6c. Under Link Location, Enter the actual URL into the text box.  (See image 3.15) 

Image 3.15
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6d. Click OK once you are done. The link should appear on the page. 
 
 
Step 7: Save   
 
7a.  Now save your page by choosing Save from the File pull-down Menu OR by clicking on the 
Save Icon at the top. (See image 3.16) 
 

 
 

Image  
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Chapter 4: Performance 
 
Before you upload the folder containing your Intermediate ePortfolio website, you will need to 
perform a few tests to ensure your site will function properly.  The steps below will guide you on 
how to view your Portfolio and double check that all your files have been saved correctly. 
 
Step 1: View portfolio before uploading 
   
1a. Close the Netscape Composer application. 
1b. Go to the folder containing your website.  
This should be on the Floppy Drive A.  Inside the Floppy drive A, you will find the folder you 
created called ePortfolio. (Make sure your folder name does not contain any commas or 
spaces). 
 
1c. Double-click the ePortfolio folder and click on your Images folder.  Make sure all the images 
are in your images folder. 
Again, please be sure none of the file names contain commas, dashes or spaces.(See image 4.1) 
  
1d. Click through all the following sections of your website: 
 

• about.html 
• classes.html 
• contact.html 
• goals.html 
• index.html 
• links.html 
• resume.html 

 
Make sure it contains all the information you entered previously.   
 
 

1  

Image 4.1  
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Step 2: What goes into your ePortfolio   
  
Before going to next step, review what will make up the content for each individual page of your 
ePortfolio: 
 
Index/Welcome – Here, you will write a welcome statement and introduce yourself to the 
people who are going to be viewing your ePortfolio.  
 
About Me – In this section, you will write about your past, and present. Remember to keep your 
information professional and write concisely. 
 
Resume – This is where you should add your most current resume. In order to maintain a good 
format of the resume, make sure the following: 

• Your resume should be inside the table. 
• Copy and paste your resume from Microsoft Word application by section. 
• Your Faculty Advisor and/or your Co-op Faculty should revise your resume to make sure 

the resume is free of errors  
• For privacy, please include your name and email address as contact information.  DO 

NOT INCLUDE your home address or phone number.  
• Keep your email address professional. For example, if your full name is “Sharon Smith”, 

your email address should look somewhat like this: SSMITH@yahoo.com”.  
• Do not provide a personal email address like Sharon_BabyGirl@yahoo.com”.  

 
Classes and Projects – This is where you should add a collection of your projects from your 
academic experience and/or your professional experience that will demonstrate your proficiency 
and growth. Projects that may added in this area are: 
 
Academic Professional Personal 
Draft and Revised Essays Internship Projects Certification and special 

training 
Term Papers Major related Projects Transcripts 
Research projects Community service Projects Website Projects 
PowerPoint presentations Leadership projects Video clips 
Spreadsheet projects Journal Audio clips 
Excel Projects   
Class trips   
 
Educational Goal – This is where you can write about your educational goal. Your goals may 
include the following: 
Your plans to graduate 
Pursuing an advanced degree after graduation 
Career plans 
Educational Interests 
 
Links – Add some of your favorite links.  
 
Contact Me – Add only your email address. 
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Chapter 5: Zipping / Compressing 
 
Now you are ready to zip the folder and upload it to “My Collection Area” in Blackboard 6 
platform.  Following the next set of steps, you will now use WinZip to compress your files and 
ready them for upload to your ePortfolio at Blackboard 6 platform.  
 
Step 1: Zip or Compress your ePortfolio folder. 
1a. From your Floppy drive A, right-click your eportfolio folder. A menu will appear with 
WinZip (see image 5.1) 
 
1b. Select the Add to Zip file. (see image 5.1) 
 

 
 

Image 5.1 
1c. Now click on Use Evaluation Version (see image 5.2) 
 

 
 
 

Image 5.2 
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1d. Under Compression make sure NONE is selected, then click Add. (see image 5.3) 
 

Path

Finally Click 
Add  

Select None

Image 5.3
 

 
 
The next window will list all the files, which correspond to the files in your ePortfolio folder. (See 
image 5.4) 
 

 
 

Image 
1e. Close this window, by clicking on the X button in the upper right hand corner of the window 
(see image 5.4). 
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Step 2: Check Zipped ePortfolio folder located in your Floppy or Removable 
Storage Device 
 
2a.  Check to see if the two folders are now in your Floppy drive or Removable Storage  Device, 
as shown in the image below.  
 
The eportfolio.zip is the file you will be uploading to the  Blackboard 6 ePortfolio Area. (In the 
image below, the icon will look like a filing Cabinet.) (See image 5.5) 
 
 

 
 

Image 5.5 
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Note: If you are using Windows XP, which has a built in compressor program, you can also 
compact your “eportfolio” folder.  Below are instructional steps that will guide you if you choose 
to use the Windows XP Compression program. 
 
Right-Click On the ePortfolio folder, and a menu will appear.  Select Send To > 
Compressed (zipped) folder (click with the left mouse button) 
 

 
 
 
 Once you select this option a Zipped Folder is created and appears under your original 
 eportfolio folder. (Take a look on how the folder icon looks, with a zipped image) 
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Chapter 6: Logon to Blackboard 6 & ePortfolio    
 
You need to login to Blackboard 6 in order to upload your webpage files to the Blackboard 
ePortfolio Area.  Following the next set of steps, you will now logon to Blackboard 6 ePortfolio 
Area. 
 
Step 1 Login  
 
           In order to logon to Blackboard 6, please open your Internet Explorer  
           or Netscape Navigator browser and go to http://bb.laguardia.edu/.  
 
1a. Click on                                            
 
 
 
      
1b. Enter your User Id and password. (See image 6.2) 

Image 6.1

 
 

 
 

Image  
1c. Under Username, Enter your first name period last name.  For example, the name Karen 
Smith would be entered karen.smith 
 
1d. Under Password, enter the default password which is the first 5 digits of your Social 
Security number.  For example, if your SS# is 122-33-0456 – you would enter 12233. 
 
If the default password doesn’t work, try password blackboard or ePortfolio. 
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Step 2: ePortfolio Tab 
 
2a. You may have to login twice when you click on ePortfolio Tab.  After entering your userid 
and password, please navigate to the ePortfolio area. (See image 6.3) 
 

 
 

Click on the link 
to enter 

Image 6.3 
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Chapter 7: Depositing work to your Storage Area 
 
Overview of Storage Area 
 
Once you have entered the ePortfolio area by clicking on the ePortfolio tab, you will be in the "My 
Collection" section of the "Storage Area".  (See image 7.1) 
 
This Storage Area is a place inside of Blackboard where users can upload files that relate to their 
educational activities.  It can be thought of as your portable floppy disk, which can be accessed 
from any location as long as there is an Internet connection.  Users can use the storage area to 
collect materials they might use in their various courses.  
 
The first step in creating an ePortfolio will be collecting your work, by saving files in a folder 
called "My Collection" on the LaGuardia server. "My Collection" will provide folders where you can 
store your work from specific courses you've taken at LaGuardia: First Year Experience, 
Introductory Course in Your Major, Urban Studies, Cooperative Education, and Capstone Course 
in Your Major. You will also have a folder called Other Courses to store any other materials you 
would like to have in your archive.  Access to this section of your material will be very limited. 
 
Students are assigned two areas for storage. The two storage places are: 
 
My Courses: This is an automatic system configured area with sub-folders, which are listed 
according to student's enrolled courses. 
 
My Files: This is a general storage area where students may have a range of content (e.g. text 
documents, audio, video, PowerPoint presentations, images, etc.) that may not be for a specific 
course.  Students are encouraged to organize their files in an easy to use filing system.  For 
example, if a student is uploading images, they may consider adding a folder called "images" in 
order to organize their work effectively. 
 
Importance of Organizing Your files 
 
After you have moved beyond these steps in this chapter, any files you wish to add to your 
Portfolio should be filed in a easy to use organized filing system. 
 
Your digital documents are just like pieces of paper except they’re in electronic format.  So, just 
like all pieces of paper, they can be well organized and easily retrieved or in total chaos.  Avoid 
spending time aimlessly looking through all your files by organizing them first in your computer 
use.  
 
Step 1: Organizing your Files:  
 
Create Folders By Topic  
Be sure to create and name folders in different categories that correspond to your files.  By 
creating folders by topic, this will help you find your files quickly and without frustration.   
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1a. In order to create a folder under the My Files folder, click on the Add folder icon  .  
Then, name your folder Audio and click Create.  
 
1b. Repeat step 1a. Three times and name your folders: Documents, Images, and 
Presentations.  These files will represent different categories to organize your files.  (See 
Image 7.1) 

 

 

 
 Image 7.1
 
Organize Files in Sub-Folders:  
 
Place your files in sub-folders by file type or theme.  If you put all your flies into one folder, it will 
surely be very difficult and time consuming to find a specific file you are looking for.   
 
For example, it’s a good idea to place your image files in different folder categorized by topic.  An 
example of this kind of categorization by different topics in a folder is illustrated below in Image 
7.2.  Notice that the Images Folder and the two subfolders make it easy to distinguish what kind 
of images will be found by creating separate subfolders with a main folder.   
 
1c. Go through the main folders you have created in steps 1a. - 1b. and figure out what kind of 
subfolders would be appropriate to better organize your files into distinct categories. 
 

To do this, click on your Main Folder and then click on the Add folder icon .  Then, name your 
subfolder and click Create.  
 

 
 Image 7.2 
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Name Files with Identifiable keywords 
Use names that are easy to recognize and relates to the file you are saving.  For example, a good 
filename would be Eng101_Midterm_Paper.doc.  On the other hand, a bad file for the same 
file would be paper.doc.  (See Image 7.3) 
 
Do not use any commas or spaces when naming your files.  Servers have problems reading files 
that have commas or spaces in them, so be sure to avoid them at all times when naming your 
files. 
 

 
 
 
1d.  Go through all the files in your folders you have created in steps 1a. -1c. and if needed, see 
which file names are not very clear and rename those files to make them easily recognizable.  
 

To do this, click any of the files you wish to rename and then click on the Edit item icon .  
Next, click on the Edit option and rename your folder using an identifiable title with no spaces or 

commas.  Then, click on Change icon . (See Image 7.4) 
 

 
 
 
Step 2: Add zipped ePortfolio folder into your My Collection > My Files 
 
2a. Click on the My Files folder. (See image 7.5) 
 

 

Image 7.3

Image 7.4 
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2b. Click on the Create folder icon. (See image 7.6) 
 

 
 
 
 
 
2c. Create a folder and name it eportfolio. Then, click on Create  
button (see image 7.7) 
 

 
 
 
 
2d.  Now, click on the folder named ePortfolio that you have just created. 
(See image 7.8) 
 
 

 

Add Item

Image 7.6

Image 7.7 

Image 7.8

Image 7.5 

Create Folder
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2e. After you clicked on your ePortfolio folder, click on the Add icon . 
 (See image 7.9) 

 

Image 7.11

 
 
2f. When the form appears in the following window, click on the Browse button, which is 
directly under the Add To Collections heading. (See image 7.10).  Find your 
zipped/compressed ePortfolio file (located in your floppy or USB drive). 
 

 

Add Item

Image 7.9

 
Image 7.10 

2g. Select the Zipped file that is shown with an icon that looks like a filing cabinet. (See image 
7.11) Then click Open.  
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2h. The next screen will show the path with the zipped folder.  Change the eportfolio title into 
something personal and easily identifiable.  For example: Winston_ePortfolio.  Be sure not to 
include any spaces or commas. 
(See image 7.12) 
 

Image 7.12 

Image 7.13 

 
 
 
2i. The screen that follows requires that you select an index file.  The index of your ePortfolio will 
be the main page or starter page.  Choose the index.html file and then click Submit. (See 
image 7.13) 
 

 
                 
 
 
The page that follows will now show a link with the title that corresponds to the title for your 
website. (See image 7.13)  
 
 
You can now click on the Properties icon to edit title, replace file, delete file, and move file to 
another folder. 
. 
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Step 3: View an existing file/item 
 
3a. Click on the link to launch your site.  
3b. Click on View Item Icon. (See image 7.10) 
  

 
 
 
 
Step 4. Modify an existing file/item              

    4a.  To modify your item, please click on properties icon .  
    4b.  See Image 7.11 below, which provides a more detailed view of the Properties screen.  
You can do the following: Save file, edit title, replace file, delete file, and move file to another 
subfolder 
 

 
 
View file: This will allow you to view a file and as well as save the file to your Floppy or 
Removable Storage drive. 
Edit: This will allow you to edit the name of a file 
Replace: This will allow you to replace a file 
Delete: This will allow you to delete a file 
Move: This will allow you to move a file to any other particular folder. 
 
 
 
Step 5: View your ePortfolio 
 

Properties View Item

Image 7.10 

Image 7.11

Allows you to 
save file and view 

Link

PLEASE NOTE: You will not be able to delete a file, but make sure you remove it first from your 
ePortfolio.  You can only delete a file if you are not linking that specific file to your Portfolio section. 
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5a. Under My Files, click on your eportfolio folder that you have added in order to preview 
your portfolio.  The folder will appear as a link.   
 
In this case, look in the My Files > eportfolio. Click on a few of those links to make sure that 
your files are correctly saved and functioning properly. (See image 7.12) 
 

 Link
 

Image 7.12  
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Chapter 8: Uploading Work to Your Portfolio Area 
 
Overview of Portfolio Area 
 
Developing your ePortfolio draws on the work you’ve done in your classes and offers you a 
chance to connect that with your other interests and activities, beyond the classroom. Digital 
technology allows you to use the Web to share your ideas with friends, family, employers and 
other colleges. 
 
The Portfolio Area allows you to place your text documents, audio files, PowerPoint 
presentations, videos, and images you’ve chosen to create your ePortfolio web page.  On your 
web page, which will be available on the World Wide Web, you can also share your interests and 
activities beyond the classroom, including hyperlinks to pages on music, movies, family, work — 
whatever you choose to share about yourself.  This portion of the ePortfolio will be public -- you 
can use your ePortfolio in many ways: as an electronic resume, an application for transfer to a 
four-year college, or to share your ideas with friends and family.  
In this chapter you will go over the following: 
 

• Registration of your ePortfolio  
• Building your ePortfolio 
• Previewing your ePortfolio 

 
Step 1: Registration 
 
1a. Click on My Portfolios (circled below). You will find 3 portfolio sections, which are not 
registered.  In order to register in any section, click on New. (see image 8.1) 
 
 

 
 
 Image 8.1 
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1b. In the form that appears now on the screen, next to Portfolio Description, type a cover letter 
to your ePortfolio.  This is your Biography page, which will serve as an introductory page to your 
audience.  (See image 8.2) 
 

 
 
 
 
Your cover letter is a personal statement that shares your motives, experiences, and ambitions to 
people viewing your ePortfolio.  Depending on your interests, write a cover letter that discusses 
briefly your personal and professional goals.  
 
Below, in image 8.3, is a Sample of a Biography Page. 
 

 
 
 
 
 
PLEASE NOTE:  
 
After registering to the Education/ Transfer section, you can then modify your biography page of 
your ePortfolio by clicking on Edit. (See image 8.4)  

 

 

Image 8.2 

Image 8.4

Image 8.3 
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Step 2: Build an ePortfolio 
2a.  Now, click on Build (see image 8.5) and then click on the My Collection button. 
       (See image 8.5). 

Image 8.5 

Image 8.6 

 

 
 
 

2b. A new window will pop up, allowing you to add your zipped ePortfolio from your Storage 
Area > My collection> My Files > eportfolio.  Click once on your ePortfolio folder and then, 
click on the circular button next to your zipped ePorfolio file.  (See image 8.6). 
 

 
 
2c.  Click on Submit. 
 
2d.  Add a title for your ePortfolio in the Title field and notes to the Text field under Description.  
Click on Submit. 

 
 
 
 
 
 
 
 
 
 
 
 
 
 

Building an Intermediate ePortfolio v.1.5_hg_10152004 33Image 8.7 



Intermediate ePortfolio: Chapter 8 

Step 3: Preview 
3a. Click on Preview in order to view your ePortfolio as shown below in image 8.8. 

 

 
Image 8.8  

 
Click on Education/Transfer link, then click on View Portfolio, and lastly click on the link 
Click to view (shown below in Image 8.9) to have the actual template of your ePortfolio be 
previewed.  
 

 
 Image 8.9 
 
 
PLEASE NOTE:  
 
When you are previewing your ePortfolio, navigate through your site and make sure to check 
that all the images and links are working.  
 
After previewing your portfolio, create a logon and send it to your instructor for review.  Go to 
Chapter 9 for instructions on how to create a logon. 
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Chapter 9:  Sharing your ePortfolio with your 
Instructors 
 
The ePortfolio Web Site is a powerful way to present your education, educational goals and 
career goals to a wider public. In the technologically advanced 21st century, you want to 
demonstrate that you are computer-savvy with the ability to use a wide variety of software 
applications. The ePortfolio presents you with the best possible option for sharing your work with 
potential employers, potential four-year schools, and with family and friends. The web site allows 
encourages you to have greater ownership over your education and your educational goals by 
designing an ePortfolio that reflects you and your learning. 
 
As a student, you have the ability to share your ePortfolio with any instructor in any of your 
courses.  Follow the steps below to learn how to share your ePortfolio and work with your 
instructor(s). 
 
Step 1: Activate your Course Sharing 
 

1a.  Navigate your mouse cursor to the Storage Area and click on Tools 
 

 
1b.  Navigate your mouse cursor to the Storage Area and click on My Course Sharing 

 
1c.  Click on Yes 

 

  
1d.  Click on the Submit button 
 
 
 
 
 
 

Building an Intermediate ePortfolio v.1.5_hg_10152004 35 



Intermediate ePortfolio: Chapter 9 

1e.  Go to the Portfolios Area and click on the Share link next to the ePortfolio you would 
like to share 

 

 
1f.  Go to the Portfolios Areas and click on the Share link next to the ePortfolio you would 
like to share 
 

 
 

1g.  Go to the Portfolios Areas and click on the Submit button 
 
After you click on the Submit button, the next screen (shown below) will confirm that your 
ePortfolio will now be shared with your instructor for the course you selected.   
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Step 2: Sharing your Work with your Instructor 
 
Assuming that you have enabled their course sharing option (pgs. 13-14) to your course, will you 
then be able to share your work with your instructor.   
 
Follow the steps below in order for your instructor to view your work: 
 

2a.  Go to My Collection and click on the My Files folder. 
 

 

  Go to any of the subfolders below the My Files folder and click on the Documents folder.   

2b.  Under your Documents folder, click on a files properties icon    next to the file that 
you would like to share with your instructor. 

 

2c.   In the next screen that appears, click on the Move hyperlink. 
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2d.  Now, click on the My Courses folder 

 

 2e.  Then, click on the BUSTECHACADEMY_SHARINGDEMO folder. 

2f.  Next, click on the Move item here hyperlink. 

 

2g.  Lastly, click on the Close hyperlink. 
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Chapter 10: Publishing your Portfolio 
 
Step 1: Create a Logon for Visitors 
1a.  Click on Logons located under the Portfolios Area and click on Create 
 (See image 9.1).           
Remember, only 3 logons can be created. 
 

 
 Image 9.1 
 
1b.  In the new window (shown in Image 9.2), enter an alias for your guest’s logon.   
 

 

Give an alias here. For example, you 
want to send this logon to your Family. 
Therefore, you may assign “family”. 

Check here, to enable your visitor’s logon.

Check only the portfolio that 
you want to share. 

 Image 9.2 
 
1c. Enter and Re-type password 
1d. Check off box next to the word Enabled 
1e.  Next to Portfolios, check the sections you want to share with your guests 
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Step 2: Send Logon Information Via Email 
    
2a.  Once the logon is created, you can add on to the message in the email or the  
subject.  Afterwards, click on Send to send your email to your instructor or any of your ePortfolio 
guests.  (See image 9.3)  Please be sure to enter the correct email address. 
 

 
 

Image 9.3  
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Chapter 11: Download Tools 
 
To modify or upload your pages from home, you will need the programs listed below.  These 
programs will need to be downloaded and installed on your personal computer.  You may not 
need to download some of these programs because they are often pre-installed on many 
computer systems.  Only install the programs if they are not currently on your computer.  
 
Please note that the computers in the LaGuardia labs are already equipped with both of these 
programs. 
 
The links below will take you to web sites where these programs can be downloaded for free.  
 

NETSCAPE Composer (Needed to modify your HTML Templates) 
Version: Netscape 7 
File Name: N7Setup.exe 
Homepage: http://home.netscape.com/download/index.html
 

INTERNET EXPLORER (Needed to transfer files to your web space) 
Version: Internet Explorer 6.0  
File Name: ie6setup.exe  

omepage: H http://www.microsoft.com/windows/ie/default.htm 

WinZip (Needed to compress files) 
Version: WinZip 9.0 ( Choose Evaluation version for free) 
File Name: winzip90.exe  
Homepage: http://winzip.com/downwzeval.htm
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Chapter 12: Troubleshooting 
 
 
If you encounter the following problem logging in to Blackboard 6 Eportfolio and receive the If 
you encounter the following problem logging in to Blackboard 6 ePortfolio and receive the 
following error message: "An error occurred in the authentication module: Empty 
ResultSet for session query." 
 
Solution:  Open Internet explorer again and type the following URL bb.laguardia.edu instead 
of bb.lagcc.cuny.edu. 
 
If the error message continues and your are using Internet Explorer 5 0r 6, then try the 
following: 
 
 
1. Open Internet Explorer. 
2. Click on Tools > Internet Options 
2. Click on the Privacy Tab. 
3.  Click on Advanced button 
4. Under Cookies, Click on Override automatic cookie handling. 
5.  Restart the browser. 
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Chapter 13: Support and Resources 
  
Links  
 
Informational site: 
http://www.eportfolio.lagcc.cuny.edu
 
Blackboard 6 and ePortfolio site: 
http://bb.laguardia.edu/
 

ePortfolio Studio 
• Location: E 312 
• Lab Hours: 10:30 p.m. to 5:30 p.m.  Monday – Friday 

(Lab may be closed if the classes are in session) 
• Phone Ext: 8420 

 
• Assistance will be provided at all times by a Student Technology Mentor or an 

Instructional Design Assistant during lab hours. 
 

• ePortfolio Workshops will be held throughout the semester.  Please visit: 
http://www.eportfolio.lagcc.cuny.edu/workshops.html 

 

ePortfolio Office 
 
Consultants: 
 

Sada H Jaman  
Email: eportfolio@lagcc.cuny.edu
Phone: 718.482.5407 
Location: M420  
 

Hector Graciano  
Email: eportfolio@lagcc.cuny.edu
Phone: 718.482.5407 
Location: M420 

 
Technical Support  
 
Contact Michael Johnson, Associate Director of Instructional Services, if you have any of the 
following problems:  

 Can't log into your ePortfolio web account 
 Forgot your password. 
 Problems with a computer in ePortfolio Studio or one of the computer labs. 

 
Michael can be reached at: 
Tel: (718) 482-6115  or Ext: 6115  
Office: E256 A 
Email: michaelj@lagcc.cuny.edu or webmaster@lagcc.cuny.edu
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